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Introduction 

About this guide 

Send-it 3.6 for NEWSflo documents the Send-it software module when installed, integrated 
and used in a NEWSflo (newspaper workflow) environment. 

If you need information about Send-it when it is installed and used together with the PrePage-it 
Web module (which is typically the case with commercial workflow packages such as PrePage-it ’10/ 
PrePage-it ’11/ PLATEflo), please consult the separate PrePage-it Web 3.5 User Guide. 

 
How to use this guide 

Chapter 1 – Send-it Basics (p.6) - contains basic, practical explanations and procedures regarding 
how to use Send-it, including: 

• how to submit jobs via Send-it 

• how to softproof them 

• how to approve/reject jobs 
 
This chapter covers everything an external customer/supplier needs to know about Send-it. Also, 
this chapter serves as a primer or introduction for internal operators. Since internal operators 
have the ability to do everything external customers/suppliers can do, everything described in 
this chapter applies to them as well. 

 
Chapter 2 – Send-it – Beyond the Basics (p.27) – explains Send-it functions/settings that only 
internal operators are authorized to do. This includes: 

• how to set up your external customers/suppliers so they can send you jobs 

• creating Send-it user accounts for external customers/suppliers 

• verifying the status of jobs submitted by any user 
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What is Send-it? 

Send-it is an optional module that may be added to an existing Polkadots workflow such as 
NEWSflo. Send-it is designed for remote job submission, e-proofing and job approval. It gives 
external customers or suppliers the ability to submit files to your RIP for preflighting and 
RIPping. It also allows them to remotely softproof and approve/reject their own jobs. Once they 
approve a job, it will appear in your workflow just like jobs that your own operators RIP 
internally at your company. Once jobs have been approved by external customers, you may take 
any necessary actions to complete and output the job. In a typical NEWSflo setup, for example, 
you would set up your publications in whatever way you are accustomed to doing and the 
remotely submitted pages will then be paired up and output. 

Send-it can be accessed by any internal operator who has a Send-it user account. All jobs 
submitted by external customers via Send-it will be visible to internal operators, who will be able 
to softproof them if they wish. In addition, operators can also verify status information about 
submitted jobs, such as: who submitted it? when? in which queue? who approved or deleted a 
job? etc. 

Training videos 

To help you get started, there are some Training Videos that give you a quick visual overview, for 
example: 

• Uploading & softproofing pages 

• How to install PrePage-it Upload 
 
Please consult your Polkadots Software dealer or view them directly from the Polkadots web site 
http://www.polkadots.ca/support/training_videos.asp. 

Software version 

This edition of Send-it 3.6 for NEWSflo is based on the version 3.6.1.3 of Send-it (February 2011). It 
has been updated from the original edition, called Send-it 3.x Practical Guide, which was based on 
version 3.0.1.0 (November 2008). 

Technical information 

Send-it works as a Client-Server application. The Server application is installed on a server 
machine (typically dedicated). Send-it Clients can then be launched from any web browser on any 
machine, both internally at the company and externally at any of the company’s 
customers/suppliers. 

When Send-it is coupled with NEWSflo (for newspaper production), the workflow is typically 
configured so that jobs submitted via Send-it automatically appear in the PrePage-it Client. A 
detailed technical explanation of this setup can be found in the tech note How to set up Send-it with 
NEWSflo. 

http://www.polkadots.ca/support/training_videos.asp�
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Chapter 1 - 
Send-it Basics 

This chapter covers everything an external customer/supplier needs to know about Send-it. As 
well, it serves as a primer or introduction for internal operators, who have the ability to do 
everything external customers/suppliers can do. 

In this chapter you will find basic, practical explanations and procedures regarding how to use 
Send-it. 

External customers/suppliers log on to Send-it with Super-User or User accounts (see User 
Accounts on p. 28 for more information about Send-it accounts). 

Reminder 

The features and options you see in the Send-it interface depend on (i) which Send-it 
options were purchased and (ii) which user account you are currently logged on with. 
Therefore your Send-it interface may not show all options/features mentioned in this 
guide. For more information, see User Accounts on p. 28. 

What can external customers / suppliers do with Send-it? 

Reminder 

Internal operators have the ability to do everything external customers/suppliers can 
do - this includes everything described in this chapter. 

Send-it allows external customers/suppliers to: 

• submit jobs to be pre-flighted and RIPped 

• see list of RIPped jobs 

• view softproofs: low-res Previews, PDF softproofs (optional), and View-it hi-res softproofs 
(optional) 

• approve/flush pages & jobs 
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• write and read annotation comments in a View-it softproof 

• receive e-mail notifications of events (e.g. approved jobs, errors) 
 

Launching Send-it 

Note 

Send-it Clients can be launched from any workstation equipped with one of the 
following operating systems: Win XP Pro (or higher), Mac OS 10.4 (or higher). 

Send-it Clients can be opened in any web browser on any workstation by: 

1. Typing the IP address or URL of the Send-it Server. 
2. Logging on with your Send-it Login username/password. 

 

 

IP address 

An external customer/supplier must use the external, public IP address or URL of the Send-it 
Server (add port number if other than port 80). 

Internal operators should use the internal, private IP address or URL of the Send-it Server (add 
port number if other than port 80). 

Type IP address 
or URL of the 
Send-it Server. 

Type your Login 
username and Password. 
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Web browsers 

Minimum requirements: 

• Firefox 2 or 3 (Mac or PC) 

• Internet Explorer 7 (PC) 

• Safari v.3 (Mac OS 10.4 or higher) 
 
Browser tips 

• it is recommended to use recent versions of web browsers, as listed in the previous section 

• avoid adding extra toolbars and add-ons (e.g. Google toolbar, etc.) 

• pop-up blockers can prevent some Send-it windows from being displayed 

• if portions of the Send-it interface are displayed incorrectly or missing: 

 try to reload/refresh the web page using the web browser’s Reload or Refresh 
command 

 try clearing the web browser’s cache or temporary internet files 

 see the section Basic Troubleshooting Tips on p.43 for details 
 

How to submit job pages - Overview 
The procedure below describes how to create a job with Send-it, including how to upload, 
softproof, and approve/reject job files. 

Create a job name 

1. Click the Jobs link, then click the New button to create a new job name/folder. 
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Tip 

If an operator creates a job and they want that job to be visible to a particular 
customer, then select that customer as the Owner. In addition, you can make a job 
visible to every user under the Owner by checking the box Make this job visible for the 
entire group. 

The new job will be listed in the Job List. 

 

 

Give a Job name. 

Select the job’s Owner 
(see Tip below). 
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Single Pages 

1. Upload pages in one of the following ways: 
 

Method A: PrePage-it Upload: (see Uploading Files on p.14 for a detailed explanation) 

Log on to PrePage-it Upload, select the new job folder you just created, then select a suitable 
Pages queue. Finally drag and drop the page files you want preflighted and RIPped, then 
click the Upload button. 

   

 
Method B: PrePage-it Printer: (see Uploading Files on p.14 for a detailed explanation) 

Log on to PrePage-it Upload, select the new job folder you just created, then select a suitable 
Pages queue (see previous figure). Next, print a job file from any Mac or PC application, 
selecting ToPrePageitServer as the printer. Finally, go back to the PrePage-it Upload window 
and click the Upload button. 

Select Job folder where 
file will be placed. 

Drag n drop job files. 

Select Queue where 
files will be RIPped. 

Click Upload 
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Method C: Web Interface: 

Click on the link of the new job you just created, then click the Pages link. Now upload a 
page from the File Upload panel so it can be preflighted and RIPped. 

 

 
2. Softproof single pages from the Pages tab in one of the following formats: 

a low-res Preview 
b med-res PDF (optional - click PDF icon  if available) 
c hi-res View-it softproof (optional – click View-it link if available) 

 

Print using 
ToPrePageitServer. 

a. Select a file (click Browse). 

b. Select a PAGES queue 
(Preflight profile). 

c. Click Send-it button. 
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Note 

Med-Res PDF proofing files are available for softproofing from the PDF icon on the 
condition that they have been already produced by the PrePage-it queue during 
RIPping. 

3. Approve pages / jobs in the following way: 

 If you are set up with page approval, then select one or more pages and click the 
Approve button from the Pages window. 
  or   

 If you are set up with job approval, then when all pages are ok, Approve the whole job 
from the Job List window. 
  or   

 If a page or job is not good, you can Delete selected page(s) or Flush the entire job. 

Preview (low-res softproof) 

View-it (hi-res softproof) 

PDF ROOM Proof (med-res single-page softproof) 
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Note 

Send-it approval may be configured on a per-job or per-page basis. If you are set up 
with page approval, then rather than approving the entire job, you must approve 
individual pages – you will not have the option of approving the entire job as shown 
in the figure above. 

Tip 

As an alternative, a page may also be approved from within the View-it softproof 
window. 

Approve selected page(s). 

Approve entire job. 

Delete selected page(s). 

Flush (delete) entire job. 
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Important 

When the terms Flush / Reject / Delete are used in reference to a page or job, they all 
have the same meaning i.e. the RIPped files will actually be deleted from the hard 
disk. 

Uploading Files 
The general procedure for submitting a job is outlined in the section How to submit job pages - 
Overview, starting on p.8. This section explains the specifics about how to install the PrePage-it 
Upload and PrePage-it Printer and how to use these tools to upload files. 

Uploading Overview 

In Send-it there are currently three methods for submitting job files to the RIP: 

• Web Interface’s File Upload (Pages tab) 

• PrePage-it Upload utility 

• PrePage-it Printer (ToPrePageitServer) 
 

Note 

The Java applet that was used for uploading files in prior versions has been replaced 
by the PrePage-it Upload utility. 

The terms submitting/uploading/printing files here all refer to the same thing: submitting job 
files to a PrePage-it RIP queue in order to be processed i.e. preflighted, rasterized, etc. 

Web Interface 

The File Upload panel within the Pages tab of the web interface allows you to submit job files 
directly from the web interface (see figure below). However it is disadvantaged by the fact that 
you can only upload one file at a time. 
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PrePage-it Upload & Printer 

Two other methods exist for submitting jobs: PrePage-it Upload and PrePage-it Printer. These are 
separate, external utilities that can be used without logging on to Send-it. PrePage-it Upload allows 
you to submit PS or PDF jobs by dragging and dropping them unto the PrePage-it Upload 
window. The PrePage-it Printer utility creates a printer called ToPrePageitServer, which you can use to 
print jobs to RIP queues from any application. These tools can be installed and used on Mac or 
PC workstations. 

PrePage-it Upload/Printer provide more convenient ways of submitting jobs. PrePage-it Upload allows 
you to drag multiple job files unto the PrePage-it Upload window. The PrePage-it Printer allows you 
to print jobs in the intuitive manner that many operators are used to doing. 

Note 

The PrePage-it Upload and PrePage-it Printer tools can be used on Windows XP Pro (or higher) 
and Mac OS 10.4 (or higher). 

Installing PrePage-it Upload & Printer 

The PrePage-it Upload Setup is an installer which installs both the PrePage-it Upload and PrePage-it Printer 
tools. It must be installed on each workstation where these tools will be used. There are two 
installers – one for Mac (zip) and one for PC (exe). 

  

a. Select a file (click Browse). 

b. Select a PAGES queue 
(Preflight profile). 

c. Click Send-it button. 
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These installers can be downloaded either from the Send-it Login screen by clicking the link 
Click here to install Prepage-it Upload or from the Send-it File Upload panel by clicking the link 
Or try Prepage-it Upload. 

  

To install: 

1. Launch the PrePage-it Upload Setup and follow the instructions provided. 

Warning 

When PrePage-it Upload is installed on a Mac OS X 10.5, a security feature prevents the 
PrePage-it Printer from being created. Therefore this security feature must be disabled in 
the Mac OS X System Preferences before running the PrePage-it Upload Setup. A detailed 
account of this topic can be found in the tech note PrePage-it Upload & Mac OS 10.5. 

2. When prompted with the following window, you should provide the Send-it Host 
information i.e. the IP address or URL of the server machine. 
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Note 

For external customers/suppliers who install PrePage-it Upload, the Send-it Host 
information must be the external, public IP address or URL of the server machine. 
Internal operators must provide the internal, private IP address or URL of the 
Send-it server. 

3. The Port and Printer Service settings can usually be left at their defaults. If you need to 
change them, you may do so at this point. Note that if the port used by your Send-it 
server is different from the default port 80, then it is important to specify the correct Port 
setting here. 

 
After a successful installation, you will see two items added: the PrePage-it Upload application (on 
the Windows Desktop or the Mac Applications folder) and a printer called ToPrePageitServer. 

   

 

Specify Host information of Send-it server: 
-external/public IP address (external customers/suppliers) 
or 
-internal/private IP address (internal operators) 

Keep default settings for Port and Printer unless your 
Send-it server has a custom port (other than 80). 
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Submitting jobs with PrePage-it Upload & Printer 

The following procedure outlines how to submit jobs via the PrePage-it Upload or PrePage Printer. 
This single procedure describes both tools. 

1. Launch the PrePage-it Upload application and log in with your Send-it account. If necessary, 
click the Server arrow and select your server. 

 

2. In the PrePage-it Upload window shown below, specify the Job and Queue where you want 
to submit a file. If necessary, create a new Job folder by clicking File > Add Job or by 
clicking the Add Job icon. 

Note 

The Job folder and Queue that you select here applies whether you drag and drop files 
onto the PrePage-it Upload window or print them using the PrePage-it Printer. 
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Tip 

In a typical workflow setup, the PrePage-it Upload application window should always 
be kept open when you are submitting jobs, whether by drag n drop or by printing. If 
it’s closed, you will be automatically prompted to log on to PrePage-it Upload after 
you've submitted a file via the PrePage-it Printer. 

3. Drag and drop: If you want to drag and drop PS or PDF files, drag them unto the 
PrePage-it Upload window (figure above). 

-or- 

Print: To print a file from an application, select the ToPrePageitServer printer when printing 
from your application (figure below). 

Select Job folder where 
file will be placed. 

Drag n drop job files. 

Select Queue where 
files will be RIPped. 

Click Upload 

If necessary, click the 
Add Job icon to create 
a new Job folder. 



  S E N D - I T  3 . 6  F O R  N E W S F L O  

-20- 

 

 
4. When all files appear in the PrePage-it Upload window, regardless how they were 

submitted, click the Upload button. 

  

 

Tip 

To automatically open the Send-it window, click the Show Web Entry button. 

Click Show Web Entry 
to open Send-it interface. 

Click Upload to 
submit listed files. 

Print using 
ToPrePageitServer 
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Viewing Tools 
View-it 

View-it is an optional, payable module that may be added to Send-it. 

View-it is a high-resolution softproof of the RIPped data, showing the actual rasterized job as it will 
be printed on the plate. The proof is shown in a web browser and includes a number of tools for 
easy viewing (zooming, rotation), color information, approval/rejection, measuring (angles, 
distance) and annotation comments. Colors can be viewed individually or together. 

To know more about View-it: 

• watch a quick video tutorial directly from the Polkadots web site 
http://www.polkadots.ca/support/training_videos.asp 

• consult the View-it 3.0 Help page by clicking the (Help) link from inside the View-it 3.0 window 
 
Preview 

Clicking the Preview toolbar button will show quick, low-resolution previews of all selected 
RIPped pages. These previews can be downloaded or saved to your hard disk by clicking the 
Download button from inside the Preview window. A zipped file will be created containing a TIFF 
or JPG preview of each selected page. 

View modes 

 

Job pages can be viewed in one of the following modes, as selected in the View By dropdown 
menu (shown above): 

• View by Icon 

• View by List 
 
View by Icon shows the thumbnail preview of pages. You can change the size of the thumbnails 
by clicking one of the [A] links. 

View by List displays information about pages without showing any preview. Information includes 
original filename, page size, colors, etc. This view allows you to list many more pages at once. 

Job Filter 

The Job Filter helps you to quickly find a job when your Job List has become too long to scan 
through visually. 

http://www.polkadots.ca/support/training_videos.asp�
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In the Filter box found at the top of the Job List window, you can filter out the job list by typing 
all or part of a job name. After typing the filter characters, press Enter (on keyboard) or click the 
Arrow button. 

It will filter the job list down to only those jobs containing the specified filter characters 
anywhere in the job name. 

To return to the full job list, empty the Filter box and press Enter. 

Selection of pages 

Here is a list of techniques for selecting pages in Send-it: 

• You can select multiple adjacent pages by clicking inside a page and dragging the mouse 
across all other desired pages. You can also deselect pages in the same way. In addition, 
this procedure can be repeated in order to select several “groups” of non- adjacent pages 
inside the same job e.g. p.4-7, 12-19, 22-26. (Icon View only) 

Note 

Please note the selection procedure described above (i.e. dragging across pages) is not 
supported in Internet Explorer, only in Firefox and Safari. 

• You can select a list of consecutive pages by (i) clicking on the first page and (ii) 
Shift+clicking the last page you wish to select. (List View only) 

• You can select a page while automatically deselecting all other selected pages. To do so, 
middle-click or Shift+click a page. (Icon View only) 

• You can click the Select All toolbar button. (Icon & List View) 

• You can click individual pages. (Icon & List View) 
 

Tip 

Pages can be deselected in exactly the same way as they are selected. 

a. type all or part of  
the job’s filename 

b. click Arrow button 
or press Enter key 
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External User Accounts 
Some external customers/suppliers have more than one employee in their company who uploads 
pages to Send-it and approves/rejects jobs. To manage this, employees of an external supplier 
may be attributed a Super-User account or a User account. 

Suppliers that have a Super-User account can create additional User accounts for employees of their 
own company, for example, one account per employee. Alternatively, a supplier with multiple 
employees can have everyone submit pages to Send-it and approve/reject jobs using the same 
Super-User account. To decide which of these two setups would be more suitable for a given 
supplier, the following factors should be considered: 

• Send-it will keep a record of the main actions taken by each user account. That is, every 
time a file is submitted/approved/rejected, the records will show the filename, 
timedate stamp and username for each action taken by any user. 

• When logged in to Send-it with a Super-User account, you can create one or more additional 
User accounts - when logged in with a User account, you cannot create or manage other 
User accounts. 

• A Super-User can be authorized to see signatures whereas a User can never be authorized to 
see signatures, only pages. 

 

Note 

Since Users cannot create or manage other user accounts, the Settings tab is only 
visible to Super-Users - not Users. The Settings window is where user accounts are 
managed. 

Tip 

All the information that Operators need to know about user accounts can be found in 
the section User Accounts on p.28. 

Super-Users 

A Super-User works for a supplier or client of the main company. He/she would typically be the 
supplying company’s prepress manager or person responsible for creating and submitting jobs 
destined to be printed at the main company’s printing press. 

A Super-User can do anything that a User can do, as well as a few other things. They can: 

• create Users 
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• list/softproof/approve/reject job pages from their own user group (i.e. jobs submitted by 
themselves or a User they have created) 

• list and submit files to Pages and Upload Only queues (except hidden queues) 
 
Users 

Users also work for a supplier or client of the main company. However, unlike the Super-User, they 
cannot manage user accounts and they can never see signatures, only pages. Also, a User can only 
see their own jobs - other User’s jobs are inaccessible. 

They can: 

• list/softproof/approve/reject only their own jobs (i.e. pages) 

• list and submit files to Pages queues and Upload Only queues (except hidden queues) 
 
How to manage external user accounts 

A Super-User can create and modify Send-it user accounts for their own employees (i.e. Users). 

To create a new User: 

1. In the Settings tab, select Add New from the dropdown list. 

  

2. Specify the required User information: 
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a Login, Password and Confirm are required. Full Name and Description are optional. 
b Class is determined automatically - it cannot be changed manually. 
c Click the Add button. 

 
To modify settings for a User: 

1. Select a User from the dropdown list. 

 

2. Make the required changes and click the Modify button. 
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Note 

To remove a user, select the user from dropdown list and click the Delete button. This 
will delete everything associated with the user, including jobs on the hard disk (see 
figure below). 
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Chapter 2 - 
Send-it – Beyond the Basics 

This chapter contains additional explanations and procedures about Send-it which regard only 
internal operators. 

Reminder 

In addition to what is explained in this chapter, internal operators also have the ability 
to do everything external customers/suppliers can do, which includes everything 
described in Chapter 1 - Send-it Basics (starting on p.6). 

Internal operators log on to Send-it with Operator accounts (see User Accounts on p. 28 for more 
information about Send-it accounts). 

What can internal operators do with Send-it? 
Send-it allows internal operators to do everything external customers/suppliers can do, plus 
some additional functions, as listed below: 

• set up external customers/suppliers so they can send jobs to your RIP - this includes 
creating Send-it user accounts for external customers/suppliers 

• verify the status of jobs submitted by any user, including: 

 Upload History (list of submitted, uploaded files with corresponding 
date/queue/username) 

 Operation History (list of actions executed by users e.g. approval, deletion, overwrite a 
page) 

• view and manage jobs being processed by Send-it queues (Queue Management window) 

• use Send-it tools, including: 

 Renumber pages 

 PDF Booklet (create PDF softproof booklet of selected pages) 

 Proof (hard proof pages to one of your printers) 
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 Merge Colors (merge two colors from the same page into a single plate color) 

User Accounts 
This section contains more detailed information on user accounts. 

General info 

Send-it has 4 levels or “classes” of users: Administrator, Operator, Super-User and User. 

From highest to lowest rights/permissions: 

1. Administrator 

2. Operator 

3. Super-User 

4. User 

 

Levels 1 and 2 (Administrator and Operators) are internal employees of the company who purchased 
Send-it. 

Levels 3 and 4 (Super-Users and Users) are their customers/suppliers i.e. those external to your 
company who submit files to your RIP. 

Note 

For information regarding Super-User and User accounts for external 
customers/suppliers, please refer to the section External User Accounts on p.23. 

For further information about setting up your customers, refer to the section How to 
set up your external customers/ suppliers to use Send-it on p.33. 

Note that all levels of users can: 

• create jobs 

• submit files to Pages and Upload Only queues (see note below) 
 

User levels for 
internal employees. 

User levels for external 
customers / suppliers. 
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Tip 

Any queue can be configured as visible to some users and invisible to others. 
Therefore if a user is configured so that all queues are made invisible to him, he will 
not be able to submit jobs. 

Administrator 

There is one Send-it Administrator. The administrator can: 

• create any type of user account i.e. Operator/Super-User/User 

• set general Send-it preferences in the Settings tab: 

 visibility of queues (for all users) 

 e-mail (staff) notifications 

 server configuration 

• list/softproof/approve/reject all jobs 

• do everything Operators/Super-Users/Users can do 
 

Note 

Administrator configuration should only be performed by personnel who are 
technically trained with Send-it and Polkadots workflows in general. 

Tip 

The administrator logs on with username = admin. A default password will be 
supplied to you by your dealer, but it can be changed at any time by the administrator. 

Operators 

Operators are a company’s internal employees. They can: 

• list/softproof/approve/reject all jobs 

• do everything Super-Users/Users can do 

• create Super-User accounts 

 decide which queues a Super-User can see (Queue Visibility) 
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• do queue management from the Queues tab 

• see Status information for all jobs 
 
A more detailed list can be found in the section What can internal operators do with Send-it? on 
p.27. 

Reminder 

For information regarding Super-User and User accounts for external 
customers/suppliers, please refer to the section External User Accounts on p.23. 

Tip 

To see the Send-it interface that your customers/suppliers are using when they 
submit jobs to you, create a Super-User or User account and log on with that account. 

User groups 

A User Group refers to a “user” and all others below him in the user hierarchy, as illustrated in the 
examples below. 

 

 

Owner 

If you want a job that you are creating to be visible and accessible to a particular user (e.g. one of 
your customers/suppliers), then select them as Owner. For example, an internal Operator can create 
a job which is visible to an external supplier (e.g. Super-User) by choosing them as the owner of the 
job. 

User Group medjournal consists of: 
-medjournal (super-user) 
-Larry (user) 
-Dr Smith (user) 

User Group Mary consists of: 
-Mary (operator) 
-abpharma (super-user) 
-acmeprint (super-user) 
-Pierre (user) 
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You can designate someone as the owner of a job when you create a new job (see figure below). 
In addition, you can make the job visible to every user under the owner (i.e. his entire user group) 
by checking the box Make this job visible for the entire group. 

 

 
Managing user accounts 
Creating a new user 

1. In the Settings tab, select Add New from the dropdown list. 

  

2. Specify the required User information: 
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a Login, Password and Confirm are required. Full Name and Description are optional. 
b Class is determined automatically - it cannot be changed manually. 
c Access to the Signatures tab is not normally required for external suppliers, 

therefore uncheck Allow super-user to access signatures tab. 
d Click the Add button. 

3. Now that the user has been created, re-select it from the dropdown list and set the Queue 
Visibility for this user (i.e. which RIP queues this user will be able to see and upload files 
to): 

a For each queue, specify whether it should be visible  or hidden . 
b Click the Modify button. 
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Modifying / Deleting an existing user 

You can modify the settings for a user by selecting their username from the dropdown list (see 
previous figure), making the required changes and clicking the Modify button. Similarly, you can 
completely delete a user by clicking the Delete button. 

Note 

Removing a user will delete everything associated with the user, including jobs on the 
hard disk (see figure below). 

 

How to set up your external customers/ suppliers to use 
Send-it 
The following is a summary of the main points regarding (i) how to set up Send-it for your 
customers/suppliers and (ii) some specifics on how they can work with it: 

• each one of your customers/suppliers should be assigned at least one Super-User account 
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• the Super-User can manage user accounts for his own company, that is he can create User 
accounts for any other employee of his company who needs to submit jobs, softproof 
them, etc. 

• if you prefer, the Administrator can create User accounts for a customer/supplier rather than 
letting the Super-User do this 

• all Super-Users and Users will be able to log on to Send-it from their own workstation by (i) 
typing your Send-it Server’s External, Public IP Address or URL into any web browser and (ii) 
logging on with their Login name and Password 

 

 

Tip 

If you don’t know the external, public IP address of your Send-it Server, open a web 
browser directly on the server machine and go to the following web site: 
http://www.whatismyip.com/. If in doubt, please refer to your network 
administrator. 

• the Send-it interface for external customers is similar to the one for internal operators, 
except that the Send-it logo is shown in the top left corner and Super-Users and Users have 
limited access and functionality 

type Public IP 
Address or URL of  
the Send-it Server 

type Login 
username and 
Password 

http://www.whatismyip.com/�
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• Super-Users and Users will be able to submit pages to your PrePage-it/RIP queues, softproof 
them and approve/reject them, just like your own internal operators do 

Tip 

If you wish to prevent some Super-Users and Users from submitting jobs directly into a 
PrePage-it queue, you can hide the queues and ask them to submit via the Upload 
Only queue (see p.36 for details). 

• internal operators will also be able to softproof and approve/reject jobs that have been 
submitted by external customers/suppliers 

• annotation comments can be written by anyone directly in a View-it softproof and will be 
visible to everyone 

• once a job is approved, internal operators can take over and complete the job in whatever 
way they are accustomed to doing, depending on the workflow setup: 

 in a NEWSflo setup: create and enable a publication in the Publication Planner, then let 
NEWSflo pair the pages together 
or 

 in a commerical setup: impose the low-res pages in your usual imposition application, 
then print/resend your imposition back to PrePage-it in order to create the 1-bit 
TIFFs and output the plates 

Queues (Preflight profiles) 
Queues, or Preflight profiles, determine how pages are preflighted and RIPped after they’re 
uploaded. Send-it lists two types of queues: Pages (Normalize) and Upload Only. 
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In this section we explain the difference between these two types of queues, as well as some basic 
queue management that can be carried out by a Send-it Operator or Administrator. 

Pages (Normalize) queues 

 

These queues preflight and process single-pages, RIPping them into rasterized, contone pages. 
As a result, all pages are “normalized” into a uniform, standard file type. 

Typically, pages are processed through one of these queues: 

• NORM_PAGES_CMYK → forces a page to CMYK (4 plates max.) 

• NORM_PAGES_K → forces a page to the black plate (1 plate max.) 

• NORM_PAGES_SPOT → preserves all plate colors (process + spots) in a page 
 
Each RIPped page includes: 

• hi-res separations (for output) 

• med-res component (for proofing) 

• low-res page (for imposition or page pairing / containing OPI link to hi-res) 
 
Upload Only 

 

The Upload Only queue provides a way of exchanging files between Users/Super-users (external 
suppliers/customers) and Operators (internal company). Similar to an FTP Client, it can be used to 
upload and download files between a company and its suppliers. Anyone with a Send-it account 
can upload any type of file. This means that not only can users transfer PS or PDF jobs, but also 
files that cannot be sent directly to a RIP e.g. native Quark/InDesign/text files. 

 

 

 

PDF that has been uploaded 
via Upload Only queue. 

Click download to save a copy of 
the PDF on your workstation. 
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When a job is submitted to the Upload Only queue, it will appear in the Notes panel of the Pages 
tab (see figure above). Once it is listed in the Notes panel of a job, any operator or user who has 
access to that particular job can download a copy of the file to their workstation. 

 clicking Download allows you to save the file on your hard disk 

 the file will remain in the Notes panel until it is deleted by putting a checkmark next to 
the file and then clicking the Delete link 

 
 

 

If a file is submitted with PrePage-it Upload, the Job folder as well as the queue Pages:Upload Only 
must be specified. 

 

 

 

 

 

Tip 

You can prevent a customer/supplier from submitting jobs directly to a RIP queue 
by hiding all queues except the Upload Only queue. 

Upload Only in 
PrePage-it Web’s 
Pages tab. 

Upload Only in 
PrePage-it Upload 
module. 

Click the Delete link to remove 
all selected (checkmarked) files. 
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Upload Only - sample workflow 

One possible use for the Upload Only “queue” is for external suppliers/customers who might have 
difficulty submitting their own jobs and therefore require the simplest possible method for 
uploading their files. Such a method could be implemented through the following procedure: 

1. Create a job folder for your customer. 
2. Have your customer upload their pages to that job folder using the Upload Only queue. 
3. Locate their pages in the Notes panel and submit them to the appropriate RIP queue. 
4. Afterwards, they will be able to see the softproofs of their job and can then approve the 

pages if acceptable. 
 
Queue Management 

The Queue Management window allows you to view and manage jobs being processed by Send-it 
queues. 

 

Click the Queues link to display the 
Queue Management window. 
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Queue Status 

• Ready is displayed when the RIP is started and ready to process your jobs, otherwise the 
display shows Stopped or Suspended 
 

 

 

 

 

 

 

 
• the status of a queue is set to Normal by default, but it can be changed to Rush, Hold or 

Disable 
 Rush: jobs submitted to queues set to Rush Priority will be processed before jobs 

submitted in other queues 

 Hold: jobs submitted to queues on Hold will not be processed until you release them – 
they will be listed in the On Hold window until you select the job and click the Release 
button (note: if you decide not to process a job, you can delete it) 

 

 Disable: makes a queue inactive – it will not process any jobs 
 
Queue Scaling 

 

Normal Priority queue 

Queues are ready to process your jobs 

Rush Priority queue 

Queue on Hold 

Disable queue 

Scale queue 

Delete job 

Release job 

Scale queue 
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• a queue can be set with a Scaling value so that all jobs going through that queue will be 
scaled by the specified amount 

 

 
Job Status 

• when a job is waiting to be processed, it is displayed in the Queue Waiting window – from 
here you can set or change the status of an individual job by clicking the Rush, Hold or 
Delete button 

 

 

Reset job 

• occasionally a job may get stuck and jam the system, preventing other jobs from being 
processed - if this occurs, try clicking the Reset button as this is often sufficient to unblock 
the system 

Rush job 

Hold job 

Delete job 

Queue Waiting window 



  S E N D - I T  3 . 6  F O R  N E W S F L O  

-41- 

 

Status / History 
Status information about a job can be useful: 

• for tracking job progress and operator activity 

• as a reference 

• for troubleshooting 
 

 

Each job includes a Status tab (see figure above), which shows the Upload History and Operations 
History for that job: 

• Upload History shows information about all uploaded files (filename, date, user, etc.) 

• Operations History shows information about operations that are carried out after files are 
uploaded (e.g. deletions, approvals) 

Reset PrePage-it 
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Send-it tools 

 

Renumber 

• use this tool if you want to correct or change the page numbering of selected pages 

• select single or multiple pages 

• if multiple pages are selected, the number you specify will be for the first selected page – 
subsequent pages will be numbered consecutively 

 
PDF Booklet 

• download a low-resolution or medium-resolution PDF booklet 

• by clicking the toolbar button PDF Booklet, all selected pages are gathered into a multiple-
page PDF 

 
Proof 

• print hard proofs of selected pages 

• click the Proof button and select the desired proofing queue/printer from the dropdown 
list 

 
Merge Colors 

This tool allows you to merge together two (or more) color plates from the same page into a 
single plate color. A typical use of the Merge Colors tool is with pages where two plate colors with 
similar names (e.g. Pantone 123 CV and Pantone 123 CVC) were unintentionally produced and were 
actually supposed to be on the same plate. 

How to merge colors 

To merge two colors of a RIPped page: 

1. Select the page and click the Merge Colors toolbar button. 
2. Select the two colors you want to merge (e.g. Pantone 293 CVC and Pantone 172 CVC in the 

figure below). 
3. Select the plate they should be merged into (Pantone 172 CVC in figure below). 
4. Click the Merge button. 
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Basic Troubleshooting Tips 
This section includes some basic troubleshooting guidelines and tips in a question and answer 
format. 

 
Q: If portions of the Send-it interface are displayed incorrectly or missing? 

A1: Try to Reload/Refresh the web page. Web browsers generally have a Reload or Refresh 
command (see figure below). 

 

  

Select colors to merge 

From the dropdown list, select the 
plate they should be merged into. 

Click Merge button 
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Refresh / Reload a web page 

F
I
R
E
F
O
X  

 

S
A
F
A
R
I 

 

 

I
N
T
E
R
N
E
T 

 
E
X
P
L
O
R
E
R 

 

 

Reload button or 
CTRL+R (PC)or 
Command+R (Mac) 

Refresh or F5 (PC) 

Reload button or 
Command+R (Mac) 
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A2: If this doesn’t work, try erasing the web browser’s cache and then Reload/Refresh the web 
page. Try this, for example, if you notice a display problem occurring after a software update. 

To clear the web browser’s cache: 

• Firefox: click Tools > Clear Private Data or Clear Recent History 

• Safari: click Safari > Reset Safari 

• Internet Explorer: click Tools > Internet Options > Browsing History > Delete 
 

Q: Some windows are not opening when you click a link in the Send-it Client? 

A1: Make sure you are using recent versions of web browsers. 

A2: Pop-up blockers can prevent some Send-it windows from being displayed – try de-activating 
them. 

A3: Avoid adding extra toolbars and add-ons (e.g. Google toolbar, etc.). 

 

Q: In a workflow which includes a dedicated Send-it Server and the PrePage-it Client: if 2 customers submit jobs 
with identical filenames, the second job may show up in the same PrePage-it Client folder as the first job. 

A: If this occurs, you should do the following in the PrePage-it Client: 

1. Rename the files from the second job. 
2. If necessary, manually create a new job folder for the second job. 
3. Now drag & drop the RIPped pages belonging the second job over to the correct folder. 

 

 



 
 
 

 
 
 

 

 

 

 

Polkadots Software Inc. 

2501 Dollard 
Montreal, Qc, H8N 1S2, Canada 

Phone (514) 595-6866 
Fax (514) 595-6012 

http://www.polkadots.ca/ 
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